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= Unity AR+GPS Location Docs (v3.0+)

Guide

Quickstart

AR Foundation

Either starting from an empty project or an existing one, open the Package Manager

window by clicking on Window -> Package Manager and install the AR Foundation package,

as well as the AR Core XR Plugin and/or the AR Kit XR Plugin , depending on which

platforms you are targeting.
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AR Foundation
Version 2.0.2 (2

com.unity.xr.arfoundation
Author: Unity Technologies Inc.

A collection of MonoBehaviours and C# utilities for working
with AR Subsystems.

Includes

GameObject menu items for creating an AR setup
MonoBehaviours that control AR session lifecycle and create
GameObjects from detected, real-world trackable features
Scale handling

Face tracking

Install

Next, import the unity AR+GPS Location package, either from the asset store, or from a

.unitypackage you have downloaded from our github repository.
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unity-ar-gps-location-v3
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Then, remove the default ‘Main Camera' from the scene.
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Create Shaded
& SampleScene
=~ Main Camera
= Directional Lid

Select Children
Select Prefab Root

Create Empty

>
| 2
>
>
>
>
>
>

Project B Console
Create

W Favorites Assets

Right-click on the Hierarchy and goto AR+GPS -> Create Basic Scene Structure .
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Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object
OIS 2D Object
SEatcIvIE Effects
Y Favorites Light

7 Assets Audio

VYVVYVYVYY

Resources

™ Packages ARLocationRoot
N GPS Stage Object
GPS Hotspot Object

Create Basic Scene Structure

A Can't calculate tangents, because mesh 'Widget' doesn't contain normals. Auto Generate Lighting On

This will automatically populate the scene with all the Game Objects and Components for a

basic AR+GPS experience!

"R Pivot 7 Global # Collab ~

i= Hierarchy - -‘rScene € Game Asset Store
Create Shaded 20 @ 0 ¢ 5 3 Gizmos
<t SampleScene
™ Directional Light
¥ AR Session
™ AR Session Origin
® AR Camera
¥ ARLocationRoot
¥ GPS Stage Object
¥ Capsule

Project B Console

Create

W Favorites Assets

7 Assets e —
7 ARLocation

7 Plugins

7 Resources

7 Scenes ARLocation
7 Packages

Now just click on the GPS Stage Object and onthe Inspector window, go into Location

Options -> Location , and put the geographical coordinates of the location you want the
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Nt - -

Location Options

Location Input Type
Location

Latitude
Longitude
Altitude

Altitude Mode
Label

Placement Options

Debug
Debug Mode

Events

Object Location Updated (GameObject, Location, Int32)

List is Empty

Object Position Updated (GameObject, Location, Int32)

List is Empty

That's about it! Now you just need to build the project. On iOS just remember to set the

Camera Usage Description and Location Usage Description strings on the Player

Guide | Unity AR+GPS Location Docs (v3.0+)

Location

-23.543916
-46.643273
0

Ground Relative

Settings, and set the Achitecture to ARM64 .
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Graphics Signing Team ID
Input Automatically Sign
Physics

Physics 2D Configuration
Player

Preset Manager
Quality

Script Execution Order
Tags and Layers Use incremental GC (Experimental)

Api Compatibility Level* .NET Standard 2.0

TextMesh Pro Use on-demand resources*
Time Accelerometer Frequency™ 60 Hz
VFX Camera Usage Description* We need to use your camera for this AR Experience!
We need to use your location for this AR Experience!
Microphone Usage Description®
Mute Other Audio Sources*

Prepare iOS for Recording
Force iOS Speakers when Recording
Requires Persistent WiFi*
Allow downloads over HTTP (nonsecure)*
Supported URL schemes*
Disable HW Statistics*
Target Device iPhone + iPad
Target SDK Device SDK

Now build and deploy the project onto your device, and you should the the object at the

location you placed it at!

Vuforia

For Vuforia, starting with an empty project, open the pPackage Manager window by clicking
on Window -> Package Manager and install the AR Foundation package. This is necessary to

avoid scripting errors in the project, even though AR Foundation is not actually used here.
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o Packages
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£ SampleScene = AR Foundation
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® Main Camera
® Directional Light Ads Version 2.0.2
Alembic
Analytics Library com.unity.xr.arfoundation
Android Logcat Author: Unity Technologies Inc.
» AR Foundation A collection of MonoBehaviours and C# utilities for working
with AR Subsystems.
AR Subsystems
ARCore XR Plugin Includes
GameObject menu items for creating an AR setup
ARKit Face Tracking MonoBehaviours that control AR session lifecycle and create
ARKit XR Plugin GameObjects from detected, real-world trackable features
Scale handling
Asset Bundle Browser Face tracking

Burst
Cinemachine
Core RP Library
Custom NUnit
Project B Console Google Resonance Audio
Create Google VR Android
W Favorites Assets Google VR i0S
In App Purchasing

7 Assets P —
7 Scenes Lightweight RP

Packages Mathematics

Mobile Notifications

Last update Aug 13, 16:28 install

Auto Generate Lighting On
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Create
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3
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Auto Generate Lighting On

Make sure the current platform is set to either A ios inthe Build Settings

window.

"R Pivot (D Global # Collab ~ aa) Account ~ ' [Layers Layout

i= Hierarchy -=  #tScene € Game Asset Store -= @ Inspector
Create Shaded 20 9w ¢-T® WU - Gizmos
< SampleScene
¥ Main Camera
® Directional Light Seenecliaamid

Add Open Scenes

Platform
-fe PC, Mac & Linux Standalone ) 10S

Run in Xcode Latest version
Run in Xcode as Release
Symlink Unity libraries

Development Build

Project B Console

Create Xbox One
W Favorites Assets > Resource

£ Assets Android

- :li\;;‘)sjnon Q 5 WebGL Compression Method Default

7 Resources

7 Packages

Player Settings... Build And Run

@ Assets/Resources/ARLocationConfig.asset

Auto Generate Lighting On
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the project.

< SampleScene
¥ Main Camera
® Directional Light

Project B Console
Create

W Favorites

7 Assets

7 ARLocation
7 Plugins

77 Resources
7 Scenes

= Packages
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Assets GameObject Componen

12 Global

Window Help

W "R Pivot # Collab ~ Account  ~

#:Scene

Shaded

Layers - Layout

€ Game © Inspector

cationConfig

Earth Radius In KM
Distance Function

Initial Ground Height Guess
Min Ground Height

Max Ground Height

Vufor
Use Vuforia

A

Ground Hit Test Distance

Al

rail, ’
Compare Distance Functions (Check console output)

Open Documentation

Assets

q

ARLocationC...

Resources

Asset Labels

None

ate Lighting On

Then, remove the default 'Main Camera' from the scene.
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Create Shaded
& SampleScene
=~ Main Camera
= Directional Lid

Select Children
Select Prefab Root

Create Empty

>
| 2
>
>
>
>
>
>

Project B Console
Create

W Favorites Assets

Right-click on the Hierarchy and goto AR+GPS -> Create Basic Scene Structure .
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Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object
Project = 2D Object
SEatcIvIE Effects
Y Favorites Light

7 Assets Audio

VYVYVYYVYYVY

™ Packages

ARLocationRoot

GPS Stage Object

GPS Hotspot Object

Create Basic Scene Structure

A Can't calculate tangents, because mesh 'Widget' doesn't contain normals. Auto Generate Lighting On

This will automatically populate the scene with all the Game Objects and Components for a

basic AR+GPS experience!

mAPivot @ Global # Collab ~ faa’ Account - Layers - Layout

Hierarchy -= " #Scene € Game Asset Store - © Inspector
Create Shaded o w ¢

< SampleScene
® Directional Light
¥ ARCamera
® Plane Finder
® ARLocationRoot
™ GPS Stage Object

Project B Console
Create

W Favorites Assets > Resources

7 Assets

P ARLocation
7 Plugins
77 Resources

7 Scenes ARLocationC... VuforiaConf

7 Packages

Auto Generate Lighting On

Now just click on the GPs Stage object and onthe Inspector window, gointo Location
Options -> Location , and put the geographical coordinates of the location you want the

object to appear at.
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Location Input Type Location
Location

Latitude -23.543916
Longitude -46.643273
Altitude 0

Altitude Mode Ground Relative
Label

Placement Options

Debug
Debug Mode

Events

Object Location Updated (GameObject, Location, Int32)

List is Empty

Object Position Updated (GameObject, Location, Int32)
List is Empty

Go to Resources -> VuforiaConfiguration and make sure that Device Tracker -> Track
Device Pose is checked and that Tracking Mode is setto POSITIONAL . It also
recommended that you enable Arcore support by following the instructions herer4, and

setting ARCore Requirement to OPTIONAL in the configuration.
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oad Object Targets on
Trained Targets Continuous S/

Digital Eyewear
Device Type Handheld

Databases

No Databases found. Add Database

Disable model extraction frorf™

Video Background

Enable video background v

Video Background Shader B Custom/VideoBackground
Number Divisions 2

Overflow geometry cLIp

Matte Shader B Custom/ClippingMask

Device Tracker
Track Device Pose

POSITIONAL

ARCore Requirement OPTIONAL

That's about it! Now you just need to build the project. On iOS just remember to set the

Camera Usage Description and Location Usage Description strings on the Player

Settings.
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Graphics Signing Team ID

Input Automatically Sign

Physics

Physics 2D Configuration

Player

Preset Manager

Quality

Script Execution Order

Tags and Layers

TextMesh Pro Use on-demand resources*

Time Accelerometer Frequency™ 60 Hz

VFX Camera Usage Description* We need to use your camera for this AR Experience!
We need to use your location for this AR Experience!

Api Compatibility Level* .NET Standard 2.0

Use incremental GC (Experimental)

Microphone Usage Description®
Mute Other Audio Sources*

Prepare iOS for Recording
Force iOS Speakers when Recording
Requires Persistent WiFi*
Allow downloads over HTTP (nonsecure)*
Supported URL schemes*
Disable HW Statistics*
Target Device iPhone + iPad
Target SDK Device SDK

Now build and deploy the project onto your device, and you should the the object at the

location you placed it at!

Basic scene structure

AR Foundation

To create a basic scene structure manually, you need to first create the basic AR Foundation
game objects by going to the Game Object menu (i.e. right-click on the Hierarchy

window) on clicking on the following items:

® XR -> AR Session

® XR -> AR Session Origin
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Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object
2D Object

>
»>
>
»
»
»>
»>
>

Project B Console .
mluj one AR Session Origin

AR Session

7 Assets 1 .
9 ARLocation . AR Default Point Cloud
9 Editor " AR Default Plane
 Loca A\

7 Sample Assets
7 Samples
7 Scripts
% Sounds
7 Textures
7 Plugins

Resulting in the following scene structure:
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= Hierarchy
Create
U New Scene
= Directional Light
= AR Session
= AR Session Origin
= AR Camera

Project B Console

Next, click on the AR Session Origin object, and add a ARPlaneManager component to it.
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" AR Session Origin Position
* AR Camera (8 Rotation

R Scale

¥ AR Session Origin (Script)
Camera AR Camera (Camera)

Add Component

Project B Console
Create
7 Assets Assets > Scenes
= ARLocation
7 Editor
7 LocationPaths " ’.
7 Locations A\ A\
eshes
7= Prefabs
7 Debug
7 Sample Assets
7 Samples
7 Scripts
% Sounds
7 Textures
7 Plugins
7 Resources
7 Scenes
@ [ARLocation]: Config already exists! Auto Generate Lighting Off

Then create a AR+GPS -> ARLocationRoot oObject as a child of the AR Session Origin .

mAPivot @ Global [ES @ Collab ~| (&3] [Account ~! fLayers  ~ [Layout
= Hierarchy - #:Scene € Game Asset Store -= @ Inspector
Create Shaded 20 @ 0 o3 ® 7 AR Session Origin
<+ New Scene* - -
™ Directional Light
¥ AR Session > I Transform
" AR Session Origin Position
* AR Camera Copy L Rotation
Paste Scale

Tag [Untagged %1 Layer [Default

Rename ¥ AR Session Origin (Script)
Duplicate

Delete Camera AR Camera (Camera)

7 AR Plane Manager (Script)
Select Children
Select Prefab Root Plane Prefab None (Game Object)
e Detection Mode Everything
Create Empty
3D Object
2D Object
Effects
Light
Audio
Video
ul
XR
Project B Console Camera
Create AR+GPS ARLocationRoot
7 Assets LR e GPS Stage Object
9 ARLocation GPS Hotspot Object

i Editor " -~ ’ Create Basic Scene Structure
A\ A\

Add Component

VYVYVYYVYY

7 LocationPaths
7 Locations
7 Materials
7 Meshes
7 Prefabs
7 Debug
7 Sample Assets
7 Samples
7 Scripts
7 Sounds
% Textures
7 Plugins
% Resources
77 Scenes
@ [ARLocation]: Config already exists! Auto Generate Lighting Off

New Scene SampleScene
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# AR Session Origin
¥ AR Camera
" ARLocationRoot

Project B Console
Create

Assets > Scenes

~UE(

New Scene

7 Assets
= ARLocation
7 Editor
7 LocationPaths
7 Locations
% Materials
7 Meshes
7= Prefabs
7 Debug
7 Sample Assets
7 Samples
7 Scripts
% Sounds
7 Textures
7 Plugins
7 Resources

SampleScene

77 Scenes
@ [ARLocation]: Config already exists!
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< Persp

Position
Rotation
Scale

B ¥ AR Location Orientation (Script)

Update Settings
Max Number Of Updates
Averaging

Average Count

Low Pass Filter Factor

Use Raw Until First Average

Smoothing
Movement Smoothing Factor

Calibration
True North Offset [
Apply Compass Tilt Compensation On i
Events

On Orientation Updated ()

List is Empty

B 7 AR Location Manager (Script)

Camera None (Camera)
Wait For AR Tracking To Start v
Restart When AR Tracking Is Restored
Set Target Frame Rate To 60 Mhz 7
Debug
Debug Mode
AR Session Events
On Tracking Started ()
List is Empty

Auto Generate Lighting Off

Ok, now the basic ArR+GPs structure is laid out! All we need now is an object to be

positioned in a given geo-location. There are a few components that will do that in different

ways, as we will see later. For now, let's create a AR+GPS -> GPS

"R Pivot (@ Global

H:Scene
Create Shaded
<4 New Scene
# Directional Light
™ AR Session
# AR Session Origin
¥ AR Camera
™ ARLocationRoot

= Hierarchy =

Copy
Paste

Rename
Duplicate
Delete

Select Children
Select Prefab Root

Create Empty
3D Object

2D Object
Effects

Light

Project B Console
Create

Assets > Scenes

77 Assets N
7 ARLocation Audio
% Editor Yy / Video
M LocationPaths ‘ ul
% Locations ‘ XR
7 Materials
= Meshes
7 Prefabs
7 Debug
7 Sample Assets
£ Samples
7 Scripts
7 Sounds
7 Textures
7 Plugins
% Resources
77 Scenes
@ [ARLocation]: Config already exists!

VYVYVYYVYYVYY

Camera

| LI

Asset Store
20 0w &I-®

€ Game

ARLocationRoot

GPS Stage Object

GPS Hotspot Object
Create Basic Scene Structure

Stage Object .

@ Collab ~ Account = [Tayers = (Layout

© Inspector

Auto Generate Lighting Off

This creates an empty GameObject with a PlaceAtLocation component added to it. So, for

something to actually appear, we should, for instance, child it to this component. Here we

just create a capsule as a child.
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# AR Session Origin
¥ AR Camera
¥ ARLocationRoot
™ GPS Stage Object
™ Capsule

Project B Console
G

7 Assets Assets > Scenes
7 ARLocation
7 Editor

™ Locationpaths (‘ (‘

Locations

New Scen

7 Sample Assets
7 Samples
7 Scripts
% Sounds
7 Textures
7 Plugins
7 Resources
7 Scenes
@ (AR on]: Config alre

Again, all is needed is to set the desired geographical coordinates in the inspector for the

PlaceAtLocation component of the GPS Stage Object to place the object in the

correspond location!

Vuforia

Again, starting with a new scene, delete the old Main camera . Then, create a Vvuforia

Engine -> AR Camera and a Vuforia Engine -> Ground Plane -> Plane Finder , to create

the basic Vuforia structure, like bellow.
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Rotation
Scale

¥ Place At Location (Script)

Location Options.
Location Input Type
Location
Latitude
Longitude
Altitude
Altitude Mode
Label
Placement Options
M nt Smoothing
Max Number Of Location Updates
Use Moving Average
Hide Object Until It Is Placed

Debug
Debug Mode

Events

Object Location Updated (GameObject, Location, Int32)

List is Empty

Object Position Updated (GameObject, Location, Int32)

List is Empty
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¥ ARCamera
™ Plane Finder

Project B Console

Create

% Materials
7 Meshes
7= Prefabs
7 Samples
2 Scripts
7 ARSession
7 Components
9 Location
7 Math
7 ScriptableObjects
3 utils
% Sounds
7 Textures
7 Plugins
7 Resources
7 Scenes
7 Packages

Assets > Scenes

~UE(

NewScene  SampleScene

@ Build completed with a result of 'Succeeded!

< Persp

Camera Preview
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Position
Rotation
Scale

¥ Camera
Clear Flags Solid Color
Background

Culling Mask Everything
Projection Perspective
FOV Axis Vertical
Field of View

Physical Camera

Clipping Planes

Viewport Rect

Depth

Rendering Path Use Graphics Settings
Target Texture None (Render Texture)
Occlusion Culling v

HDR Off

MSAA Use Graphics Settings

Allow Dynamic Resolution

® @ Audio Listener
& ¥ Vuforia Behaviour (Script)
Upgrade to Vuforia Engine 8.3.9 via Package Manager

World Center Mode DEVICE
Open Vuforia Engine configuration

! ¥/ Default Initialization Error Handler (Script)

Add Component

Auto Generate Lighting Off

As mentioned in the last section, check that Vuforia is properly configured for positional

tracking.

Now, create a AR+GPS -> ARLocationRoot oObject at the root of the scene, and the basic

= Hierarchy
Create
<4 New Scene
¥ Main Camera
* Directional Light
¥ ARCamera
™ Plane Finder
¥ ARLocationRoot

Project B Console

Create

% Materials
7 Meshes
7= Prefabs
7 Samples
2 Scripts
7 ARSession
7 Components
9 Location
7 Math
7 ScriptableObjects
3 utils
% Sounds
7 Textures
7 Plugins
77 Resources
= Scenes
7 Packages

PAPivot (D Global

H:Scene € Game Asset Store
Shaded 2 @ w

Assets > Resources

g «

ARLocationC...  VuforiaConfi

 Assets/Resources/VuforiaConfiguration.asset

& Collab ~ faa’ Account = Layers v Layout

@ Inspector

@ Build completed with a result of 'Succeeded! Auto Generate Lighting Off
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Stage Object .

mAPivot | D Global @ Collab ~| &) [Account ~ - [(Mayout
€ Game A - © Inspector =

= 7 GPS Stage Object Static ¥

- Tag ' Untagged Layer | Default :
I Transform

Position X 0 Y

Rotation X 0 Y 0

Scale X 1 Y[

ARLocationRoot
= GPS Stage Object
# Capsule 7 Place At Location (Script)

Location Options
Location Input Type
Location

Latitude

Altitude

Altitude Mode
Label

Placement Options

Debug
Debug Mode

Events

Object Location Updated (GameObject, Location, Int32)
Project B Console
List is Empty

Assets > Resources

Object Position Updated (GameObject, Location, Int32)

List is Empty

Add Component

7 Plugins
77 Resources
7 Scenes

= Packages

@ Build completed with a result of 'Succeedec Auto Generate Lighting Off

Concepts

The ARrR+GPS system works by mixing the incoming GPS data from the device with the

underlying AR tracking done by AR Foundation of Vuforia.

Both in AR Foundation and Vuforia, the AR tracking moves the camera (which starts at the

origin of the world coordinates) around so that it matches the real movement of the device.

What the ArR+GPs system does it to calculate the position and orientation of the gps-

positioned objects relative to the user/camera, both in terms of position and orientation.

For that, it is essential that at ARLocationRoot object exists in the scene, as a sibling of the
AR Camera used by the AR Tracker. Hence, in the case of AR Foundation, it will be a child of
the AR Session oOrigin , while in the case of Vuforia it will be placed at the root of the

scene.

The ARLocationRoot object must contain both a ARLocationManager and a

ARLocationOrientation components. These components will ensure that the
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The ARLocationProvider handles all the GPS data incoming from the device. It can be
placed anywhere in the scene. This data is filtered via the used configuration used by the

ARLocationProvider .

These components are the foundation of the ArR+GPs system. All the components that will
actually place the objects in the scene will listen to events emitted by them to perform all

the updates.

Altitude

Since the altitude data from mobile devices is usually unreliable, there are a few different
ways of indicating altitude/height in the Uunity AR+GPS Location plugin. The Altitude
property in all locations will be interpreted differently depending on the mode that is

chosen.

Absolute Use device's altitude data, and consider the Altitude as absolute, relative to
the sea-level.
e DeviceRelative Considers the Altitude as being relative the the device.
e GroundRelative Considersthe Altitude as being relative the the nearest detected
ground plane.

e 1gnore Disregard altitude in the calculations.

Stability and Precision

There is a certain trade-off between stability and precision; more measurements will mean,
usually, better precision, but the objects will also move with each position update, disrupting

stability and the persistence of the experience.

There are two situations in which objects will move due to the AR+GPS system: whenever

there is a location update, and whenever there is a orientation update.

So, to make objects appear more stable, use low values of Max Number Of Location
Updates , either in the individual components, or in the ARLocationProvider and in the

ARLocationOrientation (but not zero, since that means infinite number of updates).

Components
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ARLocationManager

v AR Location Manager (Script)

Camera AR Camera (Camera)
Wait For AR Tracking To Start v

Restart When AR Tracking Is Restored

Set Target Frame Rate To 60 Mhz v

Debug

Debug Mode

AR Session Events
On Tracking Started ()

List is Empty

On Tracking Lost ()
List is Empty

On Tracking Restored ()

List is Empty

Open AR+GPS Location configuration

The ARLocationManager components manages the interface between the ArR+GPs plugin
and the underlying AR session. This component is required for the AR+GPS system to

function.

It should be placed in the ARLocationRoot object, which will be either a child of the Ar

Session Origin (AR Foundation) or at the root of the scene (Vuforia).
Properties:

e camera The AR Camera that will be used for rendering the AR content. If this is not set,
the camera tagged as '"MainCamera' will be used.

® Wait For AR Traking To Start If true, wait until the AR Tracking starts to start with
location and orientation updates and object placement. Recommended.

® Restart When AR Tracking Is Restored If true, every time the AR tracking is lost and

regained, the AR+GPS system is restarted, repositioning all the objects.
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e Debug Mode When debug mode is enabled, this component will print relevant messages

to the console. Filter by 'ARLocationManager" in the log output to see the messages.
Events

® 0On Tracking Started Emitted when the AR tracking starts for the first time.
® 0On Tracking Lost Emitted whenever the AR tracking is lost.

e 0On Tracking Restored Emitted whenever the AR tracking is restored after being lost.

ARLocationProvider
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Location Provider Settings

Time Between Updates

Min Distance Between Updates
Accuracy Radius

Max Number Of Updates

Mock Data
Mock Location Data None (Location Data)

Initialization
Max Wait Time

Start Up Delay

Debug
Debug Mode

Events
On Enabled (Location)

List is Empty

On Location Updated (Location)
List is Empty

On Raw Location Updated (Location)
List is Empty

On Compass Updated (HeadingReading)
List is Empty

Open AR+GPS Location configuration

This component manages all the data incoming from the GPS and magnetic sensors. The
data is filtered according to the settings used, but you can also have access to the raw data.

This component is required for the AR+GPS system to function.
Properties:

e Time Between Updates The minimum time between consecutive location updates.
® Min Distance Between Updates The minimum distance that will trigger location updates.
® Accuracy Radius The desired accuracy radius. For instance, setting this to 25 will block

any data with error radius larger than 25 meters.
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each component.

® Mock Location Data The mock location used in-editor.

® Max Wait Time The maximum time to wait for location to be enabled on start-up.

e Start Up Delay Sets a delay for the location provider to start requesting updates. Useful
for when using Unity Remote.

e Debug Mode When debug mode is enabled, this component will print relevant messages

to the console. Filter by '‘ARLocationProvider' in the log output to see the messages.
Events:

e 0n Enabled Emitted when the first location reading is received.
® 0On Location Updated Emitted whenever a new (filtered) location data is received.
® 0On Raw Location Updated Emitted whenever a new (raw) location data is received.

® 0On Compass Updated Emitted whenever a new compass/heading data is received.

ARLocationOrientation
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Number Of Updates

Averaging
A\-‘eragE Count
Low Pass Filter Factor

Use Raw Until First Average

Smoothing
Movement Smoothing Factor

Calibration
True North Offset 0

Apply Compass Tilt Compensation On An/

Events
On QOrientation Updated ()

List is Empty

On Before Orientation Updated (Single)

List is Empty

This component manages the orientation of the ARLocationRoot Game Object, so that that
it is in synch with the geographical directions, by using the data from the device's magnetic

sensors. It should be placed on the ARLocationRoot Game Object, and is required for the

AR+GPS  system to function.

Properties:

® Max Number Of Updates The maximum number of orientation updates. The updates will

be paused after this amount. Zero means there is no limit and the updates won't be

paused automatically.

e Average Count Only update after measuring the heading N times, and take the average.
® Low Pass Filter Factor This is the low pass filter factor applied to the heading values

to reduce jitter. A zero value disables the low-pass filter, while a value of 1 will make the

filter block all value changes.

e Use Raw Until First Average If set to true, use raw heading values until measuring the

first average.

® Movement Smoothing Factor The smoothing factor on the orientation rotation on change.

Zero means disabled.
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magnetic heading added to this offset.
® Apply Compass Tilt Compensation On Android If true, apply a tilt-compensation

algorithm on Android devices.
Events:

® 0On Orientation Updated Emitted after the orientation has been updated.
® 0On Before Orientation Updated Emitted just before the orientation has been updated,

with the new y Euler angle as argument.

PlaceAtLocation

< Place At Location (Script)

Location Options

Location
Latitude
Longitude
Altitude
Altitude Mode Absolute
Label

Placement Options
Movement Smoothing
mber Of Location Updates
Use Moving Average

Hide Object Until It Is Placed

Debug
Debug Mode

Events
Object Location Updated (GameObject, Location, Int32)

List is Empty

Object Position Updated (GameObject, Location, Int32)
List is Empty
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Location Data
Location Data € Ap01 (LocationData)
Override Altitude Data i

Altitude

Altitude Mode Ground Relative

This component will place the Game Object it is attached to at a given geographical

location. This is the easiest way to place gps-positioned AR content.

Properties:

® Location Input Type The type of location coordinate input used. Either 'Location’ to
directly input location coordinates, or 'LocationData’ to use a ScriptableObject.

® Location Inputthe desired GPS coordinates here.

e Location Data A LocationData ScriptableObject storing the desired GPS coordinates to
place the object.

e Override Altitude Data If true, override the LocationData's altitude.

® Movement Smoothing The smoothing factor for movement due to GPS location
adjustments; if set to zero it is disabled.

® Max Number Of Location Updates The maximum number of times this object will be
affected by GPS location updates. Zero means no limits are imposed.

® Use Moving Average If true, use a moving average filter.

® Hide Object Until It Is Placed If true, the object will be hidden until the object is
placed at the geolocation. If will enable/disable the MeshRenderer or

SkinnedMeshRenderer when available, and enable/disable all child game objects.

Events:

® Object Location Updated Event called when the object's location is updated. The
arguments are the current GameObject, the location, and the number of location updates
received by the object so far.

® Object Position Updated Event called when the object's position is updated after a
location update. If the Movement Smoothing is larger than O, this will fire at a later time
than the Location Updated event. The arguments are the current GameObject, the

location, and the number of position updates received by the object so far.

PlaceAtLocations
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Size
Element O
Location Input Type Location
Location
Latitude
Longitude
Altitude
Altitude Mode Absolute
Label
Element 1
Location Input Type Location
Location
Latitude
Longitude
Altitude

Altitude Mode Absolute

Label

Placement Options
Prefab ¥ ARGPS LOGO

Debug
Debug Mode

This component will take an array of Locations and instantiate a given Prefab , placing

the instances in the given locations.

Hotspot
v Hotspot (Script)

Location Settings

Location Input Type Location Data
Location Data & ParqueHotspot01 (LocationData)

Override Altitude Data

Hotspot Settings
Prefab ¥ ARGPS LOGO

Position Mode Camera Position
Activation Radius p
Align To Camera 7
Distance From Camera P

Debug
Debug Mode

Events

On Hotspot Activated (GameObject)
List is Empty
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instantiated, either in front of the camera, at a given Distance From de Camera , or at the

center of the Hotspot.
Properties:

e prefab The prefab/GameObject that will be instantiated by the Hotspot.
® Pposition Mode The positioning mode. 'HotspotCenter' means the object will be
instantiated at the Hotpot's center geo-location. ‘CameraPosition' means it will be

positioned at the front of the camera.

Activation Radius The distance from the center that the user must be located to
activate the Hotspot.
e Align To Camera If true, align the instantiated object to face the camera (horizontally).
® Distance From Camera If 'PositionMode' is set to 'CameraPosition’, how far from the

camera the instantiated object should be placed.
Events:

® 0On Hotspot Activated Emitted when the hotspot is activated

MoveAlongPath
v Move Along Path (Script)

Path Settings
Location Path 4 Zombie Path 02 (LocationPath)
Speed il
Up X 0
Loop o
Auto Play v

Spline Sample Count 250
Line Renderer None (Line Renderer)
Offset 0]

Placement Settings
Altitude Mode Ground Relative
Max Number Of Location Updates #

Debug
Debug Mode

Moves a game object along a given LocationPath .
Properties:

e Location Path The LocationPath describing the path to be traversed.
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e Loop Iftrue, play the path traversal in a loop.

e Auto Play If true, start playing automatically.

e Spline Sample Count The number of points-per-segment used to calculate the spline.

e Line Renderer If present, renders the spline in the scene using the given line renderer.

e offset The parameters offset; marks the initial position of the object along the curve.

e Altitude Mode The altitude mode. 'Absolute’ means absolute altitude, relative to the sea
level. '‘DeviceRelative' means it is relative to the device's initial position. 'GroundRelative'
means relative to the nearest detected plane, and ‘Ignore' means the altitude is ignored

(equivalent to setting it to zero).

PlaceAlongPath

¥ Place Along Path (Script)

Path Settings
Path & Zombie Path (LocationPath)
Prefab ¥ ARGPS LOGO
Object Count 10
Spline Sample Size 200
Placement Settings
Movement Smoothing
Max Number Of Location Updates
Use Moving Average
Hide Object Until It Is Placed

Debug

Debug Mode

Instantiates the given prefab , placing the instances along the Path .
Properties:

e path The LocationPath describing the path where objects will be placed.

e prefab The prefab to be instantiated.

e Object Count How many instances will be created.

e Spline Sample Size The number of points-per-segment used to calculate the spline.

e Movement Smoothing The smoothing factor for movement due to GPS location
adjustments; if set to zero it is disabled.

® Max Number Of Location Updates The maximum number of times this object will be
affected by GPS location updates. Zero means no limits are imposed.

e Use Moving Average If true, use a moving average filter.
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SkinnedMeshRenderer when available, and enable/disable all child game objects.

RenderPathLine

v Render Path Line (Script)

Location Path @ AR Location Path (LocationPath)
Altitude Mode Absolute

Spline Sample Count 250

Line Render Sample Count 250

Line Renderer < Path Line (Line Renderer)

Renders the given LocationPath using a LineRenderer .

Properties:

® Location Path The LocationPath that will be rendered.

e Altitude Mode The altitude mode. '‘Absolute’ means absolute altitude, relative to the sea
level. 'DeviceRelative' means it is relative to the device's initial position. 'GroundRelative'
means relative to the nearest detected plane, and ‘Ignore' means the altitude is ignored
(equivalent to setting it to zero).

e Spline Sample Count The number of points-per-segment used to calculate the spline.

® Line Render Sample Count The number of points-per-segment used draw the spline.

e Line Renderer The LineRenderer to render the Path with.

ScriptableObjects
LocationData

Location
Latitude -23.540606
Longitude -46.647159
Altitude 0.5

Altitude Mode Ground Relative
Label

Holds the geo-coordinates for a location. To create, go to Create -> AR+GPS -> Location .
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LocationPath

Latitude

Altitude
locationPaths

Asset Labels

Holds data for a path/curve in space, defined by a set of geo-coordinates. To create, go to

Create -> AR+GPS -> Path .

ARLocationConfig

AR LocationConfig

Earth Radius In KM
Distance Function
Initial Ground Height Guess

Min Ground Height

Max Ground Height
Vuforia Ground Hit Test Distance
Use Vuforia
Compare Distance Functions (Check console output)

Open Documentation

This holds the global configuration for the Unity AR+GPS Location . The plugin will

automatically create a configuration file at Resources/ARLocationConfig .
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calculations.

e Distance Function The distance function used to calculate geographical distances.

e Initial Ground Height Guess The initial guess for the distance between the device and
the ground.

® Min Ground Height The minimum distance between the device and the ground (for
when detecting the floor planes)

® Max Ground Height The maximum distance between the device and the ground (for
when detecting the floor planes)

e Vuforia Ground Hit Test Distance The minimum distance, in meters, between Hit tests

when detecting the nearest ground plane in Vuforia.

Use Vuforia Enable/disable Vuforia.

Scripting

Placing objects at runtime

Suppose you want to place a single object at a given location, at runtime.

var = new Location()
{
= B)
= >
= b)
}s
var = new PlaceAtLocation.PlaceAtOptions()
{
= true,
=2,
= 0.1f,
= false
};
.AddPlaceAtComponent ( B 5 );

You can also use the PlaceAtLocation.CreatePlacedInstance to instantiate a given

Prefab/game object at a given location.
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Distance from the user to a placed object

Once an object has been placed using the PlaceAtLocation component, you can monitor

the distance from the user to the object by calling
var = . 5

This simply a shorthand for the distance between the game object and the camera. You can

also get the raw/unfiltered gps distance by doing
var = . 5

Both can be useful for triggering actions based on the distance of the user to the object.

Resetting

To reset both the AR tracker and the AR+GPS system, call

.ResetARSession((() =>

.Log("AR+GPS and AR Session were restarted!");

1);
If you want to reset only the AR+GPS system, you can write

.Restart();

Custom Location Providers

The location provider that is used by the AR+GPS system, is the unityLocationProvider
class. If, for some reason, you wish to use your own custom location provider (e.g., you want
to use a native module, or have a special type of device you want to support), just create a
class that implements the ILocationProvider interface. Then add ARGPS_CUSTOM_PROVIDER
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provider:

#telif ARGPS_CUSTOM PROVIDER
// If you want to use a custom location provider, add 'ARGPS_CUSTOM_PROVIDER
// settings, create a implementation of ILocationProvider, and instantiate i
= new ARGpsCustomLocationProvider();

f#telse

Troubleshooting

Some tips to avoid common errors:

e Make sure your device has a working GPS and magnetic sensors.

e When using AR Foundation, always check if ARKit and/or ARCore are installed.

e When using Vuforia, make sure AR Foundation package is installed but that ARKit and
ARCore are not.

e Don't use landscape mode on Android, since the tilt-compensation algorithm currently
does not support it.

e Always make sure the AR Camera istagged as the MainCamera or thatitis setin the

ARLocationManager asthe Camera property.

e When using Vuforia, make sure positional tracking is activated.

Debugging

e Many components have a Debug Mode property that, when set, will print relevant
information to the devices console. For instance, when using the PlaceAtLocation

component, you can use this to keep track of the position changes of the object.

e The Prefabs/Debug/ARLocationInfo prefab containsa canvas which will display useful

information on the screen.

Reporting bugs
You can report bugs here

You can also ask questions, submit other issues and/or feature requests in this link
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External Resources

e The ARFoundation manual
e The Unity AR Handheld forums

e The Vuforia Unity Forums

< Unity AR+GPS Location
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